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Copyright © 2002 by JAMAR Technologies, Inc. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, or translated into any language

without the prior written permission of the publisher, JAMAR Technologies, Inc.

JAMAR Technologies, Inc. Software License Agreement
This software license agreement including any warranties and special provisions, is a legal agreement between you (as an entity or
an individual) and JAMAR Technologies, Inc. By installing or otherwise using this software you are agreeing to be bound by the
terms of this agreement. If you do not agree to the terms of this agreement, return the unused software, along with all accompany-
ing documentation, to JAMAR Technologies, Inc.

The Software which accompanies this agreement is, and will remain the property of JAMAR Technologies, Inc., and is protected by
copyright law. JAMAR Technologies, Inc. is providing you with certain rights to use the Software upon your acceptance of this
agreement.

YOU MAY:
1) Use the Software on one computer;
2) Use the Software on several computers with the following provisions:

a) All computers that use this Software are located in the same building;
b) All persons using the Software are employed by the individual or entity who originally purchased the Software;

3) Use the software on a home computer with the following provisions:
a) The individual using the Software on a home computer is employed by the individual or entity who originally
purchased the Software;
b) The individual is doing work for the individual or entity who originally purchased the Software;

4) Transfer this license to another individual or entity with the following conditions:
a) All copies of the Software must be transferred;
b) No copy of the Software may remain with the original licensee;
c) All documentation must accompany the Software;

YOU MAY NOT:
1) copy the documentation which accompanies the Software;
2) sublicense, lease, transfer, or rent any portion of the Software;
3) continue to use a previous version of the Software in addition to any updates that may be received. All copies of previous
versions must be destroyed except that one copy may be kept for archival purposes;
4) reverse engineer, decompile, disassemble, modify, translate, make any attempts to reconstruct or find the source code for the
Software;

U.S. GOVERNMENT RESTRICTED RIGHTS
The Software and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the United States
Government is subject to the restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights
at 48 CFR 52.227-19, as applicable. Manufacturer is JAMAR Technologies, Inc./151 Keith Valley Road, Horsham, PA 19044.

WARRANTY
JAMAR Technologies, Inc. warrants that the media on which the Software is distributed will be free from defects for a period of
ninety (90) days from the date of delivery of the Software to you. Your sole remedy for a breach of this warranty will be that
JAMAR Technologies, Inc. will, at its option, replace any defective media returned to JAMAR Technologies, Inc. within the
warranty period or refund the purchase price of the Software.

The Software is provided “as is” without warranty of any kind, either expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose with respect to the Software and accompanying documentation.
JAMAR Technologies, Inc. does not warrant, or make any claims that the Software will meet your requirements, or that the
Software will provide uninterrupted service, or that the Software is free from errors.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM
STATE TO STATE.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES
In no event shall JAMAR Technologies, Inc. be liable for any damages whatsoever (including without limitation, direct or indirect
damages for personal injury, loss of information, loss of data, loss of business profits, business interruption, or any other loss) arising
out of the use of or inability to use the Software, even if JAMAR Technologies, Inc. has been advised of the possibility of such
damages or loss. In any case the entire liability of JAMAR Technologies, Inc. under any part of this agreement shall be limited to
the amount actually paid by you for the Software.

Windows is a registered trademarks of Microsoft Corporation. JAMAR Technologies, Inc.
recognizes the trademarks of all other companies and products mentioned in this manual.
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If you have any questions about the use of WinRAC, please call the
following number:

800-776-0940
Monday – Friday  8:00 AM to 5:00 PM  Eastern time

You may also contact us by fax at:

1-215-491-4889

or via e-mail at:

support@jamartech.com

For more information on our products, the latest news in product
development, and to download software updates, visit our web site
at:

www.jamartech.com

For information on all known issues with WinRAC, go to:

www.jamartech.com/winracsupport.htm

Address any correspondence to:

JAMAR Technologies, Inc.
151 Keith Valley Road

Horsham, PA 19044-1411
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What is WinRAC?
WinRAC is a software program designed by JAMAR Technologies, Inc. for use
with the RAC-200 Distance Measuring Instrument. This program is compatible with
the Windows 95/98 & NT operating systems and allows you to retrieve surveys
that have been stored in the RAC-200 as well as to collect data from the RAC-200
directly into your computer in a real time mode. Once your data has been entered
into the program, it can be edited in a variety of ways and comprehensive reports
can be produced.

System Requirements
The following are the minimum system requirements needed for installing and
running this program.

•IBM PC or 100% compatible
•Windows 95, Windows 98 or Windows NT (4.0 or better)
•486DX, 66 megahertz processor or better
•16 MB RAM
•SVGA Graphics Card (640x480, 256 colors minimum)
•Mouse or other pointing device
•Hard disk with 10 MB of free space
•Double speed CD ROM or higher
•Available serial port

Software Updates
Updates to our software, containing new features and bug fixes, are issued
periodically and can be downloaded from our web site at:

www.jamartech.com

For up to the minute information on all known issues with WinRAC, go to:

www.jamartech.com/WinRACsupport.htm
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Installing WinRAC
Begin the installation by placing the WinRAC CD into your CD-ROM drive. If your
CD drive is configured for Autoplay, the Installation Options program will start after
a few second. Otherwise, click on the ‘Start’ button on your Windows desktop.
Select Run from the list of options and type the command line ‘X:\setup’ where X is
the letter of your CD-ROM drive. Press OK and the Installation Options will begin.

The Installation Options program allows you to do several things in addition to
installing the software, such as checking our current product catalog or registering
your copy of the software. To install WinRAC, click on the Install WinRAC button
and the installation will begin.

The first screen you will see welcomes you to the installation for the program. Be
sure all other programs are closed before proceeding with the installation. During
the installation, files used by the program will be placed on the computer, including
some Windows system files. If other programs are open and using some of the files
that need to be installed, an error can occur during the installation process. When
you are ready to proceed, click on the Next button.
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The Software License screen allows you to review the license agreement that must
be accepted in order to use the program. Please review this agreement before select-
ing one of the options. You must accept the agreement in order to proceed with the
installation or otherwise use the program. If you agree to the license, click Yes to
continue.

The User Information Dialog requires you to enter the name of the person that will
be using the program, as well as the company name. The program's serial number,
which is a 16-digit number that can be found on the back of the program's CD case,
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must also be entered. When entering the number be sure to include the dashes. If
the serial number is entered incorrectly, you will not be allowed to proceed with the
installation. Once the information has been entered, click the Next button to con-
tinue.

The Choose Destination Location screen is used to select the directory in which
WinRAC will be installed. The default location is C:\Program Files\JAMAR\WinRAC.
Once the directory has been set, click Next to continue.
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The Select Program Folder screen is used to the name the folder the program is
stored in. Click Next to continue and a summary of the settings you have chosen
will be shown. Click Back to change any or click Next and the program files will be
copied onto your computer.

Once the program files have been copied onto the computer the Setup Complete
screen will appear. You may be prompted to restart your computer at this point.
Click Finish to exit the installation.

Once it has been installed, the program can be accessed by clicking on the Windows
Start button, going to Programs, then JAMAR and choosing WinRAC.
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Navigating in WinRAC
WinRAC has been designed to allow you to easily access the many features
and options contained in the program.  The tool bar located at the top of
the program allows quick access to some of the program's most common
features while the drop down menus provide access to all functions of the
program.

Toolbar

Open a
stored
survey

Save
current
survey

Open
Print
Setup

Preview
Report

Copy
data to

clipboard

Insert
an event

Delete
an event

Edit
Header

Edit
Description

Tables

Create
Graph

Retrieve
Survey
from

RAC-200

Collect
Real-Time

Data

Control
RAC-200

from
Keyboard

Use
Calculator
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Drop Down Menus

Edit Menu

Insert Menu

RAC-200 Menu

Window Menu

Help Menu

Tools Menu

Format Menu

File Menu
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Additional Navigation and Selection
Devices

Tabs
A number of screens in the program contain tabs to allow access to additional
information. To access this additional information, click on the tab you wish to
go to.

In this example, the General tab is currently active. To select any other the other
tabs, such as the Comments tab shown below, click on them with the mouse.

Radio Buttons
Many areas of the program contain radio buttons for selecting options and
features. In general, you click on the circle next to the item to select it. Radio
buttons are used when only one option can be selected at a time.

In the example shown here, taken from
the Print Setup,  the option to Do Not
Print Comments on the report has been
selected.
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Check Boxes
Like Radio buttons, many areas of the program contain check boxes for selecting
options and features.  In general, placing a check in the box tells the program to
include the option or feature listed. No check means the options or feature is
not to be included. Check boxes are used when more than one option can be
selected at a time.

Click on the box next to the item listed
to either select or de-select it. A black
check mark will appear when the option
is selected. In the example shown here,
taken from the Print Setup, Location,
Event Number and Event Description
are checked and will be included in the
report. Comments is not checked and
will not be included in the report.
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The Help System
Like many other Windows programs, WinRAC contains an extensive Help system
to aid you in using the program. The Help system is essentially a built-in manual
and most of the information that can be found in this printed manual can also be
found in the Help system.

There are several ways in which to access the information that is contained in the
Help. Select Help from the list of drop-down menus then choose WinRAC Help
Topics to be taken into the Table of Contents for the system, shown below.

Once here you can use the Contents to locate the item you want information on or
use the Index or Find tabs to do a search using specific keywords.
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Many screens in the program also contain Help buttons that will automatically pop-
up Help information related to the screen you are working on. If you are not sure
what to do in a certain screen, or what some of the available options mean, click on
the Help button and detailed instructions will appear.

From downloading a survey, to editing a file, to producing a report, all the information
needed to properly use the program can be found in the Help system.
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Customizing WinRAC
WinRAC has been designed to allow you to tailor the program to fit your needs.
The main area used to do this is the Preferences menu, which can be accessed by
clicking on the File menu, then selecting Preferences.

Preferences
The Preferences window allows you to customize how your data will be displayed
to fit your needs. There are three tabs within the Preferences that can be used to
customize the program to suit your needs.

Edit Screen Setup

The Edit Screen Setup tab is use to select the type, style and size of the font to
be used in the program and on reports. In the Change Fonts field you can
select either Title Font or Survey Font and adjust the settings for either part of
the report. Changes that are made will be shown in the preview area above the
Change Fonts field. Existing files can be changed to these default setting by
selecting Set Font to Default in the Format menu, which is discussed on page
5-3.
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Agency Name/Comments

The Agency Name/Comments tab allows you to customize the font setting for
the Report Titles and Comments, as well as store multiple sets of titles or
comments for quick access when working with files. This tab also allows you
to set your own Field Names and choose what field the Survey ID should be
placed in. The entries you select for the Field Names will be used in the Header
of your data files, so we recommend giving some thought to what you want
these fields to be named.

To create a new set of titles or comments, click on the Add button and a blank
field will appear where you can enter the new information. The Delete button
can be used to remove a set of titles or comments that are no longer needed.
Note that you cannot delete the first set of titles. Titles that are saved can be
accessed when preparing to print a report by clicking on the Headings/Header
Info tab in the Print Setup. Comments that are saved can be accessed by
selecting Edit Header in the Edit menu, which is discussed in Chapter 5.

You may adjust the font type, style, size and color for any line in the title in any
combination. Click on the line you want to adjust and you will see the selected
line listed in the Font field. The Select Font button can then be used to make
changes. You may adjust the font for the comments in the same way, but note
that the comments can only be customized as a whole, not line by line. The
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Print Sample Page button in the Font field allows you to print a preview of how
the comments and titles will appear.

The Field Names area of the tab can be used to assign your own names to
specific fields. To change a name, click on the field name to modify and type in
the new name. This area can also be used to assign where the Survey ID
should be placed in the data. Select the radio button next to the field in which
you wish to have the ID placed.

Event Description Tables

The Event Description Tables tab allows you to load multiple sets of tables
containing plain language descriptions of the numeric events used during the
data collection. To enter a description, click on the line next to the number you
wish to describe and enter the information. To assign a name to the specific
table you are creating, use the Default Description Table field. To create a new
table, click on the Add button and a blank table will appear where you can enter
the new information. The Delete button can be used to remove a table that is no
longer needed. The Import button can be used to import an existing RACOMM
table into the program.

Tables can be assigned to a survey using the Description Tables function of
the Tools menu, which is discussed in Chapter 5.

3-4



4-1

Chapter 4

Creating and
Opening Data
Files

Chapter 4 – Creating and Opening Data Files



WinRAC   Reference Manual

Creating and Opening Data Files
There are three ways in WinRAC  to create or bring up a data file for editing:
downloading a stored survey from the RAC-200, collecting data in the Real Time
mode, and retrieving an existing file from you computer.

Retrieve Stored Survey
Survey information that has been stored
in the memory on the RAC-200 can be
retrieved into the program by selecting
Retrieve Stored Survey from the RAC-
200 menu or clicking on the Retrieve
Survey icon in the toolbar.

To retrieve a survey, you will need an open serial port on your computer, a power
supply for the RAC-200 and a serial cable to connect the RAC-200 to the computer.

Computer serial ports are generally either 25 pin or 9 pin male plugs and there may
be more than one on your computer. Serial ports are designated as COMx where x is
a number from 1 to 4. You must correctly identify the port number you are plugging
into in order to download your data. If you are unsure of the port number, consult
your computer’s manual or contact your computer support person.

After selecting Retrieve Stored Data, the Read RAC-200 window will appear. This
screen will show the currently selected baud rate and COM port to be used for the
download. To change either the baud rate or COM port, click on the Setup button
and then click on the radio button that corresponds with your selection. The baud
rate you select must match the one
selected in the RAC-200. Once
these items are set, click on the
Begin button and you will see a
message telling you to begin dump-
ing the RAC-200.

To begin the download process
from the RAC-200, press the PRNT
and 8 keys on the RAC-200 then
press ENTR. The currently selected
baud rate will then be displayed.
Use the ADD and SUB keys to ad-
just this setting then press ENTR.
The beginning location is then dis-
played. If you want to start down-
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loading data at a different location number, key in the number desired and press the
ENTR button. Otherwise just press ENTR. Code 0 is then displayed. If you wish to
download only certain event codes, key them in here. WinRAC allows you to print
selected print codes, so unless you have a specific reason not to download all
events, use the default setting and press ENTR.

The RAC-200 then displays the last date entered into the unit and you will see the
message Enter the Survey Date displayed in the message field of the Read RAC-200
window. If the date shown on the RAC-200 is not the date you want, change it by
using the 0 through 9 keys then press ENTR.

The RAC-200 then displays ID and you will see the message Enter the Survey
Identifier displayed in the message field of the Read RAC-200 window. The survey
ID can be a one to six digit number from 0 to 999999. Key in this number using the
0 through 9 keys then press ENTR. Note that it is not necessary to key in all six
numbers. For instance, if the survey ID is one hundred twenty three, key in 123, not
000123. If you do not key in a survey ID, then the ID will default to zero. Once the ID
has been entered press ENTR.

The RAC-200 will then begin sending data to the program. You will see numbers
quickly flashing on the RAC-200 display and a blue status bar will begin to move
across the Read RAC-200 window. Once the download is complete, a window will
appear containing the survey data. The information in the survey can then be
edited, as described in Chapter 5.

Collecting Real Time Data
Survey information can be directly input
into the program as it is collected in real
time by selecting Real Time Data from the
RAC-200 menu or clicking on the Real Time
icon .

To collect data in the real time mode, you will need an open serial port on your
computer, a power supply for the RAC-200 (cigarette lighter adapter) and a serial
cable to connect the RAC-200 to the computer.

Refer to the section Retrieve a Stored Survey on page 4-2 for information on iden-
tifying the proper COM port.

With the RAC-200 turned on and connected to the computer, select Real Time Data
and the RAC-200 to PC interface window will appear. The program will check the
currently selected COM port and if it locates a RAC-200 connected to it a graphical
display of the RAC-200 will appear on the computer screen. You will then be taken
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to the Edit Header window to setup the new survey, which is described on the next
page.

If the program does not locate a RAC-200 on the current COM port, connection
settings will appear below the RAC-200 graphical display.

There are three options other than the COM port that can be selected or adjusted
with the connection settings. When selected, the Use Keyboard button allows you
to use buttons on the keyboard to execute functions on the RAC-200, rather than
using the mouse to click on the buttons. To change back to using the mouse, click
on the use Mouse button.

The Update Frequency field allows you to adjust the rate at which the graphical
display of the RAC-200 will be updated on the computer screen to reflect what is
showing on the RAC-200 itself. A setting of 1000 will update the display every
second, while a lower number will update it more frequently.

The connection settings will show the currently selected COM port to be used for
connecting to the RAC-200. After selecting the COM port your RAC-200 is con-
nected to, click the Try button and the program will attempt to connect to the RAC-
200. Make sure the RAC-200 is on in order for the connection to be made. If the
connection is successful, you will then be taken to the Edit Header window.
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Edit Header Information

The Edit Header Information window allows you to set the information that will
be used in the header of a survey. Information can be entered for the Survey ID,
Survey Route, Survey Type, Begin Ref., End Ref., and Vehicle ID (or the names
you have assigned in the Preferences - refer to page 3-3). The Start Date and
Time can also be adjusted, as well as the comments to be used with the survey.
Comments can be entered directly or selected from the stored comments as
setup in the Preferences. After the survey data has been stored to the com-
puter, these same fields can be modified by selecting Edit Header from the Edit
menu, as described in Chapter 5.

Once you have set the header information to the format you want, click Okay
and you will be taken into the Real Time Collection Parameters window.

Real Time Collection Parameters
You are given three options for choosing when data should be read into the
survey from the RAC-200 while in Real Time mode: On Demand, By Time
Interval and By Distance Interval. The Event Desc. Table button can be used
to load a table of event descriptions to be used with the survey.

On Demand
This option allows you to receive data from the RAC-200 only when you
demand it.

By Time Interval
This option allows you to receive data from the RAC-200 at a specific time
interval. Enter a number between 1 and 999 seconds and data will be
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retrieved from the RAC-
200 each time the inter-
val occurs.

By Distance
Interval
This option allows you
to receive data from the
RAC-200 at a specific
distance interval. Enter a
distance, in miles, and
data will be retrieved from the RAC-200 each time the interval occurs.

After clicking OK for the mode in which you wish to receive data, the
Insert Real Time Event window will appear.

Insert Real Time Event
Press the [Scroll Lock] Toggle Count
Hold button to begin the survey.
Once the survey has begun, data will
be downloaded from the RAC-200
based on the real time mode you
have selected. If By Time Interval or
By Distance Interval were selected,
data will be downloaded whenever
the selected interval is reached. If
On Demand was selected, data will
only be downloaded when you re-
quest it.

To assign an Event number to downloaded data, enter the number in the Event
field. If a Description Table has been selected for the survey, the text descrip-
tion that corresponds to the number you entered will appear in the Event
Description field. If no table has been selected you can directly type in a
description in this field. A comment for the event can also be entered using the
Comment field.

Once this information has been entered, there are two ways in which to have it
included in the survey. If you are using the By Time Interval or By Distance
Interval mode, the Append Next button stores the information that has been
entered and will include it with the next set of downloaded data when the
designated interval is reached. The Append Now button will immediately down-
load data from the RAC-200 and include the event information in the survey.
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This would be used when in the On Demand mode, or if you want to include
additional events between intervals in the By Time Interval or By Distance
Interval mode.

The [Pause] Toggle Count Hold button will pause the data collection from the
RAC-200 while the End Data Collection will conclude the data collection. Once
the data collection has been ended, the survey data can be edited, as described
in Chapter 5.

Control RAC-200
This function, which can also be accessed by clicking on the Control
RAC-200 icon,  allows you to directly control the RAC-200 from your
computer. For smoothest operation, use only the WinRAC program to
make changes to the RAC-200 while in this mode. Do not use WinRAC
while also pressing keys directly on the RAC-200.

The connection setup used to control the RAC-200 from the program is the same as
with Real Time data collection. Review the previous section for additional informa-
tion on connecting to the unit from WinRAC.

When you are controlling the RAC-200 from the program, and trying to store
events in the unit, set the Update Frequency to zero. This will allow you to enter
event numbers into the RAC-200 without the update clearing the display.

Retrieving Existing Data Files
Data Files that have been saved in the pro-
gram can be retrieved by selecting Open
from the File menu or by clicking on the
Open File icon.

Once selected, the Open command will bring up a
screen similar to Windows Explorer.

Use the directory tree on the left of the screen to navigate to where you want to
open your files from then select the file from the list that appears on the right
hand side.

The File Name, Date, Time, Survey ID, Survey Route, Type Survey, Begin Ref., End
Ref., Vehicle ID# and Number of Events are listed for each file. The columns in this
screen can be resized to fit your needs. The program will remember the sizes the next
time you enter the window.
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The Print button located at the lower left allows you to print a listing of all files, with
their related information, from the currently selected directory.
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Working With Your Data Files
When a data file has either been opened from an existing directory or downloaded
from the RAC-200, there are a number of things that can be done to edit or adjust the
file. Each file appears in its own window in the program; you may have more than
one file open in the program at a time.

The information contained in the file can be adjusted and  modified in several ways,
using the Edit, Insert, Format and Tools menus, along with other features.

Edit Menu

Copy
This function, which can also be accessed
by clicking on the Copy icon, copies the

selected area to the clipboard.
The Paste command can then
be used to place the data at a
new location, either within

WinRAC or any other Windows program that has Copy and Paste capability.

Copy Formatted
This function allows you to copy data with the Column and Row Titles in-
cluded and the data in their proper row/column. This can be used to move data
to other Windows programs, such as Excel, in a more complete format than just
copying the data.

Delete an Event
This function, which can also be accessed by clicking on the De-
lete Event icon,  allows you to delete any existing event from the
study. After selecting this option, enter the number of the location
you wish to delete and click on the Delete Event button. The event
corresponding to the location selected will be removed, along with its location
number. To re-number the locations and replace the deleted number, use the
Reset First Location Number function of the Tools menu.

Edit Header
This function, which can also be accessed by clicking on the Edit
Header icon, allows you to set or adjust the information that is
stored in the header of a survey. Information can be entered for the
Survey ID, Survey Route, Survey Type, Begin Ref., End Ref., and
Vehicle ID (or the names you have assigned in the Preferences - refer to page 3-
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3). The Start Date & Time can also be adjusted, as well as the comments to be
used with the survey. Comments can be entered directly or selected from the
stored comments as setup in the Preferences.

Insert Menu

Insert an Event

This function, which can also be accessed by clicking on the Insert Event icon,
allows you to insert a new event into the study. After selecting this option,

enter where the new event should be placed by selecting an exist-
ing location number. Then, choose to either place the new event
before or after the selected location. All location numbers after the
inserted event will then be adjusted.

Format Menu

Change Unit of
Measure
This function allows you change the unit being used to measure distance in
the study. You are given the option to convert to feet, miles or kilometers. This
change will be reflected in both the Distance Units and Velocity Units entries
of the header. Changing the unit of measure will also change the data shown in
the Interval Distance, Total Distance and Velocity data columns.
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Set Font to Default
This function allows you set the fonts being used for the selected study to the
default settings as entered in the Preferences function of the File menu. When
files are originally created, they use the fonts that are currently set in the
Preferences. However, if the Preferences are changed at a later date, the change
does not affect existing files - they retain the original settings with which they
were created. This function allows you to quickly convert the fonts of an
existing file to the new Preferences settings.

Tools Menu

Reset First Distance
This function allows you to change the
Total Distance for the first event re-
corded in the survey. All subsequent
Total Distances will be updated to re-
flect the change. This tool can be use-
ful if you want a survey to begin recording distances from the first event.

Reset First Location Number
This function allows you to change the location number used for the first
event in the survey. All subsequent location numbers will be updated to reflect
the change. This tool can be useful if you want a survey to begin at a specific
location number (such as 1 rather than the default 0) or if you have deleted
events and want the location numbers to be re-sequenced to fill in the deleted
numbers.

Reset First Elapsed Time
This function allows you to change the Elapsed Time for the first event re-
corded in the survey. Subsequent Elapsed Times will be updated to reflect the
change. This tool can be useful if you want a survey to begin recording elapsed
time from the first event.

Changing the first elapsed time will also affect the Real Time listings, which are
based on the start time of the survey. To change the start time of a survey, use
the Edit Header function. The First Elapsed Time must be set to zero in order for
the Real Time listing of the first event to reflect the start time of the survey.

Merge 2 Surveys
This function allows you to combine two surveys into one.  You must have at
least two files currently open in order to use the Merge function.
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In general, there are two reasons why you would want to merge surveys. One,
if you covered the same area more than once, recording a different set of
events each time, you would want to overlay the surveys. In this case, each
survey should start at the same location, with a preset distance of zero, and
should be approximately the same length. Two, if you started a second survey
at the point at which you ended the first, you would want to chain the second
survey to the end of the first. In this case, the starting Elapsed Time or Total
Distance of the second survey should correspond with the end of the first
survey.

After selecting the Merge 2 Surveys option, the Merge window will open.

If only two studies are currently open, they will be listed in the Select the
Surveys to Merge field. If more than two are open, use these fields to select the
two you want to merge. After selecting the files to be merged, you must select
the Merge Method to use. Surveys can be merged by either Elapsed Time or
Total Distance. After selecting the method to be used, click on the Merge
button and the selected surveys will be merged into a new one. Review the new
file to be sure the data has been merged as expected, then save the new file.

Description Tables
This function, which can also be accessed by clicking on the De-
scription Tables icon, allows you to assign plain language descrip-
tions to the numeric events used during the data collection. When
you select this function, the Description Tables window will ap-
pear.

The left side of the window contains the Current Definitions. To enter a new
definition, or edit an existing one, click on the line to change and type in the
new definition.
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The right side of this window contains Saved Tables that have been pro-
grammed in the Preferences function. Use the Previous and Next buttons to
scroll through the available tables. If you would like to use one of the tables,
click on the Reload from Table on Right button and the table will be copied to
the Current Definitions field. Once the events are defined as you would like,
click the OK button and the new definitions will appear in the data file’s Event
Description column.

Graphs
This function, which can also be accessed by clicking on the
Graphs icon, lets you display your data in a variety of graphical
ways. To design your own graph, or customize the existing one,
right click on the graph itself and you will see a menu with op-
tions to access the Chart Designer and Wizard as well as several
other functions.

There are also several menu options that are available in the Graphs function.

File
In the File menu, you can choose from Save to File or Print. The Save to
File function will direct you to where the graph can be saved as a file while
the Print function allows you to select your printer and print the graph.
The graph will print in color if you are using a color printer.
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Edit
In the Edit menu, the Copy Chart function allows you to copy the graph to
the Windows clipboard. It can then be pasted into any Windows program
that supports Cut and Paste functions.

Y-Axis
This menu is used to select what unit will be used down the left side of the
graph. You can choose from Speed, Distance or Time.

X-Axis
This menu is used to select what unit will be used across the bottom of the
graph. You can choose from Distance or Time.

Additional Editing Features

Data Grid
The grid that is used to display the data can also be adjusted. Each column can
be increased or decreased in size to suit your needs. When a report is pro-
duced, the width of the columns in the report will be based on how you have
configured them in the data itself. To change the size of a column, slide your
mouse over the right margin of the column title. The mouse will turn into an
icon of two lines with arrows going in opposite directions. Hold down the
mouse key and drag the column to its desired size.

The data can also be sorted by any of the column information simply by
clicking on the column title you wish to sort by. To reset to the default order,
click on the Location column title.

Exporting
The data that is contained in a file can also be exported into the ASCII format.
Accessed from the File menu, this selection lets you save the currently active
file in an text format (.txt extension) that can be opened by a wide variety of
other programs.

You are given the option of selecting the items you want to include in the
exported file by placing check marks in their corresponding boxes. Items from
the Header, from the Survey Data and from the Survey Header can be included,
or excluded, as desired. You may choose the delimiter to be used from comma,
tab or semicolon, or pick your own. The Preview button will show you what the
exported file will look like while the Export button will prompt you to assign a
name for the new ASCII file.
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Saving
Changes you have made to the data file can be saved by selecting
Save from the File menu, or by clicking on the Save icon.

If you would like to Save the file under a different name, select
Save As from the File menu.
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Print Setup
When your data has been edited to suit your needs, you will want to
produce a report of the data. To produce a report, select Print from the
File menu, or click on the Print Setup icon, and the Print Setup window
will appear. There are four tabs in this window that can be used for
customizing your reports.

General

The first field in the General tab is Select Summary type. This is used to choose
what, if any, summary you would like to see at the end of the report. You may
choose from No Summary, Event Number and Description, Event Number Only or
Event Description Only. If the Total Event Distance box is check, this information
will be included with the chosen summary.

The Select Events field is used to pick which events you want to include in the
report. The default setting is to include all events. If you would like to exclude any,
remove the check mark from the box next to the event you wish to exclude. Similar to
the Select Events field, the Select Columns to Include field is used to pick which
columns you want to include in the report. The default setting is to include all
columns. If you would like to exclude any, remove the check mark from the box next
to the column you wish to exclude. If you do not want to include any of the
columns, check the Do Not Print Survey Data box. This would be used if you only
wanted to produce a summary of the data, without printing the data itself. Note that
the width of the columns in the report will be the same as in the data file itself. For
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more information on changing the size of the columns, refer to Working with your
data .

The Sort Data By: field allows you to choose how the data in the report should be
sorted. You can choose to sort by any of the column titles. The Locations field
allows you to pick a specific range of locations to include in the report while the
Speeds field allows you to pick a specific range of speeds to include in the report.

Comments

The Comments tab is used to pick where the comments should be shown in the
report, if at all. The comments that are shown in this tab are the ones that have been
entered for the file in the Edit Header function. If you wish to override these, type in
the new comments to be used. You can then choose to print the comments at the
top of first page only, at the top of each page, or not to print the comments at all.

Heading/Header Info
The Headings/Header Info tab is used to pick what Report Headings should be
used and what header information should be included with the report. Use the
Previous and Next buttons under Stored Headings to pick the heading desired from
the default headings that have been entered in the Preferences function. These
headings will then appear at the top center of each report page.

You can also choose to include certain Header Information with the report. If you
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select First Page Only or All Pages you can include any of the header information
by placing a check next to the information to include. This will then appear at the
beginning of the report. If the Do Not Use button is selected, no header information
will be included.

Page Setup

The Page tab is used to setup the printer you want to print to and select how the
printed pages should be formatted.
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The Current Printer Setup field provides information on the currently selected printer.
To choose a different printer, click on the ‘Setup’ button. The Orientation field
allows setting your printout for either Portrait or Landscape. The Margins field
allows you to set the margins that will be used with the printout.

The Line Spacing field allows you to set the spacing that will be used between each
interval of data. The default setting is for single spacing, but can be changed to
1.25, 1.50, 1.75 or double-spacing. The Preview field shows how the currently se-
lected margins will be spaced in the printout.

Once you have set the Print Setup to the Options desired, click on Preview to see
how the report will look or click on Print to send the report to the printer.

Preview
When in the Print Preview window, which can also be accessed by
clicking on the Preview icon, you can use the Next button to see addi-
tional pages of the report, and the Previous button to go back to pages
you’ve past.

Clicking on the Zoom button gives you a closer look at the data. You can also zoom
into any place of the report by double-clicking with you mouse at the point you
want to zoom. Scroll bars at the bottom and right of the window are used for moving
around while zoomed in. Clicking on the arrow next to the Zoom button also gives
you several options for looking at the data. The Thumbnail selection provides small
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pictures of each page of the report. The Two Pages selection shows two pages at a
time in the preview. The Whole Page selection shows a complete page in the pre-
view. The Page Width and Fill Screen selections increase the amount of screen filled
by the preview.

The ‘Printer’ button will access the Print Setup where you can choose the printer
you want to print to as well as change other options such as Portrait or Landscape
styles.  The ‘Print’ button is used to send the report to the selected printer while the
Close button will exit you out of the Print Preview.

Saving Reports for Use with JAMAR Review
JAMAR Review is a free, and freely distributable, Windows-based (95/98 &
NT) program that can be used to review and/or print traffic reports and surveys
produced by WinRAC and other JAMAR software programs. The program
allows you to distribute reports in an electronic format to those who do not
own WinRAC.

To produce files for use with JAMAR Review click on the Save button in the
Print Preview window. This save function will create an exact copy of the report
in an electronic format with a .ppf file extension. This file can then be e-mailed
or posted on a web site for review by anyone using the JAMAR Review
program, which can be download and installed for free from our web site at
www.jamartech.com.  A copy of the program is also included on the WinRAC
installation CD with the file name jamarreview.exe. Note that people using the
program can only review or print the reports, they cannot make changes to
the reports.
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